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1 System Requirements 
VP7configure™ will run on Windows 2000 or Windows XP.  A COMM port is required 
to communicate with a VP7™ box. 

2 Installation 
2.1 Installing VP7configure™ for the First Time 
If the PC has never had the VP7configure™ application installed, follow these steps to 
install the application. 

STEP 1: Insert the distribution disk into the CD-ROM drive of the PC or a CD-ROM 
drive networked to the PC and view the contents of the CD in the Windows 
Explorer window. 

STEP 2: Double click on “VP7CONFIGURE SETUP.EXE” file. 

STEP 3: Follow the on-screen instructions to install the VP7configure™ 
application. 

2.2 Removing VP7configure™ 
STEP 1: Uninstall the existing VP7configure™ application by double clicking the 

“Add/Remove Programs” applet in the Control Panel. 

STEP 2: Select “VP7configure” from the list of programs and click the 
Add/Remove button. 

STEP 3: Follow the on-screen instructions to uninstall the VP7configure™ 
application. 

2.3 Updating VP7configure™ 
STEP 1:  Remove the existing VP7configure™ application following the steps in 

Section 2.2. 

STEP 2:  Install the VP7configure™ application following the steps in Section 2.1. 
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3 Creating a Connection 
To create a new connection to a VP7™ box, select File->New Connection from the 
menu bar, or press Ctrl + N on the keyboard.  The VP7configure™ Wizard window will 
appear. 

 
Figure 1 VP7configure™ Wizard 

Westar Display Technologies, Inc. 
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4 Using the VP7configure™ Wizard 
The VP7configure™ Wizard performs the steps necessary to configure a VP7™ box.   Its 
graphical user interface outlines the logical flow for setting up a VP7™.  It can be used 
while a VP7™ is connected and changes can be applied immediately, or a file can be 
created, saved, and applied to a VP7™ at a later time. 

4.1 Connecting to a VP7™ 
To connect to a VP7™, connect the RS-232 connector of the VP7™ to the RS-232 
communications port on the computer.  Select the COM port number from the COM: 
drop-down menu.  Then click the red To Connect button.  

 
Figure 2 Connect 

If a VP7™ is detected, a window will appear asking “Do you want to load settings from 
the VP7 into the wizard?”  Select Yes if you wish to read the settings from the VP7™, 
and load them into the VP7configure™ Wizard.  Select No to retain the settings that are 
already in the VP7configure™ Wizard. 

 
Figure 3 Load Settings 

If the VP7™ was in AUTO mode, it will be set to fixed mode while editing, and can then 
be set back to AUTO mode upon disconnecting.  A message will appear indicating this.   

After connecting, the button labeled “To Connect” will change to green and be labeled 
“To Disconnect.”  The “Table” (see section 4.1.1), “Firmware Version,” and “FGPA 
Revision” will be shown. 

Westar Display Technologies, Inc. 
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To disconnect from a VP7™, click the green To Disconnect button. 

 
Figure 4 Disconnect 

4.1.1 Selecting a Table 
The VP7™ allows for 8 different “tables,” or configuration sets.  Once a VP7™ is 
connected, the “Table” drop down list will be enabled, and the table number will be 
automatically selected.  To change the table, click the drop down list, and select from 0 
through 7.  After changing the table, a window will appear asking "Do you want to load 
settings from the VP7 table into the wizard?"  Select Yes if you wish to read the settings 
from the VP7™ table, and load them into the VP7configure™ Wizard.  Select No to 
retain the settings that are already in the VP7configure™ Wizard. 

4.1.2 AUTO Table Selection 
The VP7™ can be set up to automatically load the table which matches the input video.  
A table must be created for every possible input video to use auto-mode.  Using AUTO 
mode is not recommended when the input video is constant.  AUTO mode is only 
supported in VP7™ firmware version 3.0 and later. 

To enable AUTO mode, select AUTO on Disconnect.  The option will have been already 
selected if the VP7™ was already in AUTO mode when connected.  The VP7™ will be 
set to AUTO upon disconnecting.  To disable AUTO mode, deselect AUTO on 
Disconnect, and click To Disconnect. 

Westar Display Technologies, Inc. 
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4.2 Running the Wizard  
The wizard performs the following steps: 

STEP 1: Configure input capture parameters. 

STEP 2: Define the characteristics of the output video. 

STEP 3: Select the area of interest of the input video.  Scale and position the area 
of interest onto the output video. 

STEP 4: Define the power sequences for the critical events.  Select options for 
when valid input video is lost. 

STEP 5: Select methods for controlling Contrast and Brightness. 

STEP 6: Adjust the color capture from the input video.  Adjust the input capture 
boundary and ADC clock phase. 

 
Figure 5 Wizard 

Westar Display Technologies, Inc. 
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4.2.1 Entering the Wizard 
To begin using the wizard, click Start…  If you have previously engaged the wizard, but 
closed out of the process, click Resume… to return to where you left off. To move 
directly to an individual step within the process you may click the corresponding button 
on the main window.  While inside a step, the corresponding button will be highlighted in 
a yellow square.  Starting at the beginning of the wizard is recommended when 
configuring a VP7™. 

4.2.2 Moving Between Steps 
To move to the next step in the wizard process, click Next> in the lower right hand 
corner of the window.  To move to the previous step click <Previous.  On the last step of 
the wizard, click Finish to leave the wizard.  To leave the wizard, and discard the 
changes for the current step, close the window by clicking the X in the upper right hand 
corner of the window. 

 
Figure 6 Next, Previous 

The wizard validates each step after it is performed.  When you click “Next>” or 
“<Previous,” the parameters you just entered will be checked.  If they are valid, the 
wizard will move on, and the button corresponding to the step will turn green.  If a 
problem is found, a message will be displayed describing the problem.  It will ask, 
“Continue anyway?”  If you select Yes, the wizard will move on, but the button will 
remain red.  If you select No, the wizard will remain at the current step. 

 
Figure 7 Problem Found 

Westar Display Technologies, Inc. 
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4.3 Input Setup 
The parameters for capturing the input video are defined under “Input Setup.”  This is the 
first step in the configuration process.  To go directly to this step, click the button under 
“Step #1:  Input Setup.”  

 
Figure 8 Input Setup 

Westar Display Technologies, Inc. 
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4.3.1 Input Timing Parameters 
The input timing parameters are set to match the characteristics of the input video so the 
video data can be correctly captured.  If the input parameters are changed at any time, the 
input adjustments will be reset to zero. 

4.3.1.1 VESA Standard 
There are several predefined timing specifications that can be automatically applied to the 
timing parameters.  To use a predefined standard, click the drop-down list and select the 
one you wish to use.  The fields in the “Input Timing Parameters” frame will be 
automatically filled in. 

If the parameters in the fields match one of the VESA standards in the list, that standard 
will automatically be selected in the drop-down list.  If not, Custom will be selected in 
the list. 

4.3.1.2 Scan Type 
Select Progressive if each line of input video is sent one line after the other.  Select 
Interlaced if lines are sent in two interlaced fields, one containing even numbered lines 
and the other containing odd numbered lines.  Select the “Interlaced” option that 
corresponds to the de-interlacing method that is used, Spatial or Static Mesh de-
interlacing.  Spatial de-interlacing should be used for video with high motion content 
(like a camera).  Static mesh de-interlacing should be used for low motion content video 
(like computer graphics).  Static mesh de-interlacing is supported in VP7™ firmware 
version 3.0 and later. 

If the input video is interlaced, the back porch values for the odd and even lines can be 
different.  When Interlaced is selected, an additional field for the even back porch value 
is added to the “Vertical” parameters. 

 

 

Figure 9 Progressive Scan 

Figure 10 Interlaced

Westar Display Technologies, Inc. 
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4.3.1.3 Vertical 

 
Figure 11 Vertical Timing Diagram 

Total 
Vertical Total defines the total number of lines of input video, including blanking. 

Active 
Vertical Active defines the number of active or visible lines of input video. 

 Pulse Width 
Vertical Pulse Width defines the width of the vertical sync pulse in lines. 

Back Porch 
Vertical Back Porch defines the number of lines between the end of the vertical sync 
pulse and the beginning of active video.  If Progressive is selected as the scan type, only 
“Back Porch” is used.  If Interlaced is selected, “Back Porch Odd” defines the back 
porch for the odd fields, and “Back Porch Even” defines the back porch for the even 
fields. 

Front Porch 
Vertical Front Porch defines the number of lines between the end of active video and the 
beginning of the vertical sync pulse.  It is calculated automatically when a vertical timing 
parameter changes, and cannot be set.  If Progressive is selected as the scan type, only 
“Front Porch” is shown.  If Interlaced is selected, “Front Porch Odd” shows the front 
porch for the odd fields, and “Front Porch Even” shows the front porch for the even 
fields. 

Polarity 
Vertical Polarity defines the polarity of the vertical sync pulse.  Select Positive if the 
pulse is active high and Negative if the pulse is active low. 

Westar Display Technologies, Inc. 
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4.3.1.4 Horizontal 

 
Figure 12 Horizontal Timing Diagram 

Total 
Horizontal Total defines the total number of pixels in one line of input video, including 
blanking. 

Active 
Horizontal Active defines the number of active or visible pixels of one line of input 
video. 

 Pulse Width 
Horizontal Pulse Width defines the width of the horizontal sync pulse in pixels. 

Back Porch 
Horizontal Back Porch defines the number of pixels between the end of the horizontal 
sync pulse and the beginning of active video. 

Front Porch 
Horizontal Front Porch defines the number of lines between the end of active video and 
the beginning of the horizontal sync pulse.  It is calculated automatically when a 
horizontal timing parameter changes, and cannot be set.   

Polarity 
Horizontal Polarity defines the polarity of the horizontal sync pulse.  Select Positive if 
the pulse is active high, and Negative if the pulse is active low. 

Line Time or Pixel Clock 
The capture rate can either be defined by line time or the pixel clock rate.  Select line 
time by clicking the Line Time option or pixel clock by selecting the Pixel Clock option.  
“Line Time” defines the time that it takes to scan one line of video.  Its units are 
microseconds (μsec).  “Pixel Clock” defines the rate that pixels are scanned.  Its units are 
megahertz (MHz). 

Westar Display Technologies, Inc. 
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4.3.2 Input Timing Sanity Check 
The Input Timing Sanity Check can be used as a measurement tool to verify and detect 
your input timing parameters.  Some measurements are directly measurable while others 
require some conditions to be met.  To use the Sanity Check tool click Input Timing 
Sanity Check. 

4.3.2.1 Analog RGB 
This tool is intended to help you verify that your Input Timing parameters are set up 
correctly for Analog RGB video. 

 
Figure 13  Input Timing Sanity Check (Analog RGB) 

Westar Display Technologies, Inc. 
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4.3.2.1.1 Direct Measurements 

 
Direct measurements are measurements that can be arbitrarily measured for a valid 
analog RGB source.  This means the timing of the video does not need to be known, and 
the video content can be anything.   These measurements include: 

Frame Rate (Hz) 

Vertical Total (lines) 

Vertical Sync Pulse Width (lines) 

Vertical Sync Polarity (Positive, Negative) 

Scan Type (Progressive, Interlaced) 

Horizontal Period (μs) 

Horizontal Sync Pulse Width (μs) 

Horizontal Sync Polarity (Positive, Negative) 

The Vertical Sync Pulse Width cannot be measured for some composite sync inputs.  If 
measured Vertical Sync Pulse Width is 0 or 1, adjust manually for closest match to 
known frame rate.  To adjust, click the up and down arrows. 

Westar Display Technologies, Inc. 
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4.3.2.1.2 Conditional Measurements 

 
Figure 14 Conditional Measurements 

Pixel recovery for analog inputs requires that the Horizontal Total parameter be set 
correctly.  For this reason, some of the measurements made by the Input Timing Sanity 
Check depend on the value of the Horizontal Total parameter.  In addition some of the 
measurements require video content greater than 25% gray in order to differentiate the 
active video area from the horizontal and vertical blanking intervals.  These 
measurements are included under “Conditional Measurements.”  The grouping of 
measurements is shown below: 

 
Conditional upon video content     Conditional upon Horizontal Total parameter 

 
 Vertical Active (lines)         Horizontal Active (pixels)   Pixel Clock Frequency (MHz) 

 Vertical Active Starts (lines)     Horizontal Active Start (pixels)  Horizontal Sync Pulse Width (pixels) 

 

 

4.3.2.1.3 Apply and Measure 
To apply the current Horizontal Total parameter, and measure the other timing 
parameters, click Apply and Measure.  The results will be shown in the appropriate 
fields. 

Westar Display Technologies, Inc. 
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4.3.2.1.4 Fix 
The sanity check supports a method to fix the measurements that depend on Horizontal 
Total by entering a known value after the measurement.  The pixel (sampling) clock is 
generated by the Horizontal Total parameter and the line rate of the input video.  The 
Horizontal Total parameter must equal the total (active + blanking) pixels per line of the 
input video for artifact free analog to digital conversion.  To use the fixing feature, click 
Fix. 

 
Figure 15 Fix 

If you know the correct value for the Horizontal Total, Pixel Clock Frequency, or 
Horizontal Active, click the option button beside it.  Enter the value, and click OK.  The 
Horizontal Total and the measurements that depend on the value will be adjusted 
according to the adjustment made to the parameter.  The adjusted parameters will appear 
in blue.  Click Apply and Measure again to apply the adjusted Horizontal Total, and re-
measure all the parameters. 

 

Westar Display Technologies, Inc. 

14 



VP7configure™ User’s Manual                                                                                                 Revision 7.0.4 

 

 
Westar Display Technologies, Inc. 

15 

4.3.2.1.5 Use Measurements for Input Timing Parameters 
It is recommended that you get your Input Timing parameters from the video source 
documentation and verify them with the sanity check.  However, to aid in integration, it is 
possible to use measurements made by the sanity check as the Input Timing parameters.  
After a few iterations, of Measure/Fix, the measurements made by the sanity check will 
approach the actual values of the video source.  Due to the resolution of some of these 
measurements, input capture using these measurements (specifically, Horizontal Total) as 
the Input Timing parameters will probably have artifacts and will need to be fixed.  To 
use the measurements, click Use Measurements for Input Timing Parameters. 
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4.3.2.2 TMDS and Video 
This tool is intended to help you verify that your Input Timing parameters are set up 
correctly for TMDS and Video input formats.  To measure the video parameters, click 
Measure. 

 
Figure 16 Input Timing Sanity Check (TMDS and Video) 

Westar Display Technologies, Inc. 
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4.3.2.2.1 Direct Measurements 
Direct measurements are measurements that can be arbitrarily measured for a valid 
TMDS or Video source.  This means the timing of the video does not need to be known, 
and the video content can be anything.   These measurements include: 

Vertical Total (lines) 

Vertical Sync Pulse Width (lines) 

Vertical Sync Polarity (Positive, Negative) 

Scan Type (Progressive, Interlaced) 

Frame Rate (Hz) 

Pixel Clock Frequency (MHz) 

Horizontal Period (μs) 

Horizontal Total Pixels (pixels per line) 

Horizontal Sync Pulse Width (μs) 

Horizontal Sync Pulse Width (line) 

Horizontal Sync Polarity (Positive, Negative) 

4.3.2.2.2 Conditional Measurements 
Some of the measurements made by this tool require video content greater than 25% gray 
in order to differentiate the active video area from the horizontal and vertical blanking 
intervals.  The measurements include: 

Vertical Active (lines) 

Vertical Active Start (lines) 

Horizontal Active (pixels) 

Horizontal Active Start (pixels) 

4.3.2.2.3 Use Measurements for Input Timing Parameters 
It is recommended that you get your Input Timing parameters from the video source 
documentation and verify them with the sanity check.  However, to aid in integration, it is 
possible to use measurements made by the sanity check as the Input Timing parameters.  
To use the measurements, click Use Measurements for Input Timing Parameters. 
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4.3.3 Input Electrical 
The input electrical parameters define the format of the input video.  There are three 
choices for video formats selectable by radio buttons:  Analog RGB, TMDS, and Video.  
When a format is selected, the fields to the right of the choices will change to match the 
selected format. 

4.3.3.1 Analog RGB 
Select Analog RGB if the input video format is analog RGB.  Complete the fields to the 
right to configure the analog to digital converter.  

 
Figure 17 Analog RGB 

Synchronization 
Select Digital Separate Sync if the horizontal and vertical synchronization signals are 
separate.  Select Digital Composite Sync if the horizontal and vertical synchronization 
signals are combined into one signal.  Select Analog Composite Sync (sync on green) if 
the horizontal and vertical synchronization signals are combined on the green video 
signal. 

Offset Bias 
The offset biases are added to the calibration values that eliminate the DC offset from the 
analog video signals.  Each color component (R, G, and B) has an offset bias. 

Gain Bias 
The gain biases are added to the calibration values that aligns the full analog RGB range 
of the analog video signals.  Each color component (R, G, and B) has a gain bias. 

Clamp Placement 
“Clamp Placement” defines the starting position after a horizontal sync pulse when the 
input analog signal is clamped for DC restoration.  It is programmed in increments of 
eight input clock edges.  In most cases, the clamp placement can be set to “1.” 

Clamp Width 
“Clamp Width” defines the interval that the input analog signal is clamped for DC 
restoration.  It is programmed in increments of eight input clock edges.  In most cases, 
the clamp width can be set to “4.” 

Westar Display Technologies, Inc. 
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4.3.3.2 TMDS 
Select TMDS if the input video format is TMDS. 

 
Figure 18 TMDS 

Clock Edge 
Select Falling if pixel data is latched on the falling edge of the input clock.  Select Rising 
if pixel data is latched on the rising edge of the input clock. 

Use Data Enable 
Select the option Use Data Enable to use the data enable signal to qualify active data.  
De-select the option to identify active data arbitrarily within the line. 

Data Enable Polarity 
Select Positive if active data is present when the data enable signal is high.  Select 
Negative if active data is present when the data enable signal is low. 

Westar Display Technologies, Inc. 
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4.3.3.3 Video 
Select Video if the input video format is ITU656 video.  (*NOTE* the Video option is 
only enabled on VP7 boards with firmware version 4.0 and higher). 

 
Figure 19 Video 

Input 
Select the physical connector of the input video.  Choose between Composite 1, 
Composite 2, or S-Video.  

Color Standard 
Select the color standard of the input video.  The options are NTSC M, PAL B,D,G,H,I, 
and SECAM. 

Live Update 
Select “Live Update” to update the hardware incrementally as the Video parameters are 
adjusted. 

Luminance Brightness 
Adjust the “Luminance Brightness” using the sliders, or by entering a value from 0 to 
255.  A value of 255 gives maximum brightness, 128 is the ITU level, and 0 is dark. 

Luminance Contrast 
Adjust the “Luminance Contrast” using the sliders, or by entering a value from -2 to 
1.984.  A value of 1.063 is the ITU level, 0 yields no luminance, -1 gives inverse 
luminance, and -2 gives inverse luminance. 

Chrominance Saturation 
Adjust the “Chrominance Saturation” using the sliders, or by entering a value from -2 to 
1.984.  A value of 1.0 is the ITU level, 0 yields no color, -1 gives inverse chrominance, 
and -2 gives inverse chrominance. 

Westar Display Technologies, Inc. 
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Chrominance Hue 
Adjust the “Chrominance Hue” using the sliders, or by entering a value from -180 to 
178.6 degrees.   

Sharpness 
Adjust the “Sharpness” using the sliders, or entering a value from -8 to 7. 
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4.4 Output Setup 
The parameters for the output video are configured under “Output Setup.”  This is the 
second step in the configuration process.  To go directly to this step, click the button 
under “Step #2:  Output Setup.”  

 
Figure 20 Output Setup 

Westar Display Technologies, Inc. 
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4.4.1 Output Sync 

4.4.1.1 Internal Clock 
Select Internal Clock to use an internally generated output clock to generate the output 
video. 

4.4.1.2 Frame Ratio 
Select Frame Ratio to synchronize the output video to the input video at a certain ratio 
of frames.  For every number of frames of input video, there can be a certain number of 
frames output.  When using “Frame Ratio,” the pixel clock of the output video is adjusted 
to satisfy the ratio.  Enter the number of input frames into In Frames, and the number of 
output frames into Out Frames. 

4.4.1.3 Frame Sync 
Select Frame Sync to synchronize the refresh rate of the output video to that of the input 
video.  One output frame is generated for every input frame and a constant phase 
relationship exists between the output and input frames such that no video data is lost.  
There will be limits to this feature.  At this time, we cannot guarantee the output timing 
parameters. 

4.4.1.4 External Sync 
Select External Sync to generate an output frame each time an externally supplied pulse 
is received.  As with Frame Sync, the output timing is generated at the specified clock 
rate.  The extent to which a complete output frame can be generated is determined by the 
rate of the externally supplied pulses. 

4.4.1.5 Clock 
The “Clock” field sets the rate of the output video clock, or how quickly each pixel 
datum is sent out.   
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4.4.2 Output Scan Type 
Select Progressive to scan out video one line after another.  Select interlace to scan out 
video in two interlaced fields, one with odd lines, and one with even.  When using 
interlaced, alternate options for setting the timing parameters are used (see section 4.5). 

4.4.3 Output Sync Type 

4.4.3.1 H & V 
Select this option to use separate digital H and V sync signals. 

4.4.3.2 Composite (on H) 
Select this option to combine the output H and V syncs onto the digital H sync channel.  
(A.K.A. Digital Composite Sync.)  When using this option, alternate options for setting 
the timing parameters are used (see section 4.5). 

4.4.4 Output Timing Parameters (Progressive Scan) 
The output timing parameters define the timing characteristics of the output video. 

4.4.4.1 VESA Standard 
There are several predefined timing specifications that can be automatically applied to the 
timing parameters.  To use a predefined standard, click the drop-down list and select the 
one you wish to use.  The fields in the “Output Timing Parameters” frame will be filled in 
automatically. 

If the parameters in the fields match one of the VESA standards in the list, that standard 
will automatically be selected in the drop-down list.  If not, Custom will be selected in 
the list. 

4.4.4.2 Frame Rate 
This is an indicator that shows the output frame rate.  The Frame Rate is based on the 
Line Time and the total number of lines (Vertical Total). 
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4.4.4.3 Vertical 

 
Figure 21 Vertical Timing Diagram 

Total 
Vertical Total defines the total number of lines of output video, including blanking. 

Active 
Vertical Active defines the number of active or visible lines of output video. 

 Pulse Width 
Vertical Pulse Width defines the width of the vertical pulse in lines. 

Back Porch 
Vertical Back Porch defines the number of lines between the end of the vertical sync 
pulse and the beginning of active video. 

Front Porch 
Vertical Front Porch defines the number of lines between the end of active video and the 
beginning of the vertical sync pulse.  It is calculated automatically when a vertical timing 
parameter changes, and cannot be set. 

Polarity 
Vertical Polarity defines the polarity of the vertical sync pulse.  Select Positive if the 
pulse is active high and Negative if the pulse is active low. 

Westar Display Technologies, Inc. 
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4.4.4.4 Horizontal 

 
Figure 22 Horizontal Timing Diagram 

Total 
Horizontal Total defines the total number of pixels in one line of output video, including 
blanking. 

Active 
Horizontal Active defines the number of active or visible pixels of one line of output 
video. 

 Pulse Width 
Horizontal Pulse Width defines the width of the horizontal sync pulse in pixels. 

Back Porch 
Horizontal Back Porch defines the number of pixels between the end of the horizontal 
sync pulse and the beginning of active video. 

Front Porch 
Horizontal Front Porch defines the number of lines between the end of active video and 
the beginning of the vertical sync pulse.  It is calculated automatically when a horizontal 
timing parameter changes, and cannot be set.   

Polarity 
Horizontal Polarity defines the polarity of the horizontal sync pulse.  Select Positive if 
the pulse is active high and Negative if the pulse is active low. 

Westar Display Technologies, Inc. 
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4.4.5 Output Electrical 
“Output Electrical” defines the format of the output video. 

4.4.5.1 Parallel 
Select Parallel if the output video format is parallel. 

4.4.5.2 LVDS 
Select LVDS if the output video format is LVDS (Low Voltage Different Signal). 

4.4.5.3 Data Mapping 
The output video data signals can be mapped in different fashions.  Select Normal 
(SPWG) to use the Standard Printed Wiring Group configuration.  This configuration is 
also the mapping to use for normal parallel output.  Select LDI to use the LDI 
configuration. 

4.4.5.4 Green to Grayscale 
Use the green video signal to produce monochrome output. 

4.4.5.5 6 Bit Dithered 
Dither bit 2, (b1,b0 = 0) to make a 6 bit panel appear to have 8 bits. 

4.4.5.6 Dual Pixel 
Select Dual Pixel if the display being driven requires dual pixel video. 

4.4.5.7 Clock Edge 
Select Falling Edge to output pixel data on the falling edge of the output clock.  Select 
Rising Edge to output pixel data on the rising edge of the output clock. 

4.4.5.8 DAC Used 
Select DAC Used to force the output electrical parameters to support the Westar DAC 
board.  When selected, the “Data Mapping” will be set to “SPWG 8-bit,” format set to 
“Parallel,” and Clock Edge set to “Rising.”  Toggling Discrete 0 will not be allowed in 
any power sequences, since it is used by the DAC for selecting single or dual pixel. 
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4.5 Output Setup (Interlaced Scan or Composite Sync Output) 
The parameters for the output video are configured under “Output Setup.”  Many 
parameters are common to both progressive scan and interlaced output timing.  This 
section documents the parameters that are specific to interlaced outputs or progressive 
with composite sync outputs. 

 

 
Figure 23 Output Setup (Interlaced Scan or Composite Sync Output) 

Westar Display Technologies, Inc. 
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4.5.1 Sync Format 
The Sync Format describes the behavior of the H and V sync signals during the vertical 
blanking interval for composite type syncs. 

Serration Pulses: Serration pulses are generated during the vertical sync pulse.  They 
are generated at either 1x or 2x the horizontal line rate and are positioned according to the 
horizontal front porch.  They are also known as field sync pulses.  Their width is 
described by the field sync (FS) pulse width. 

Equalization pulses: Equalization pulses are generated before and after the vertical sync 
pulse.  They are generated at either 1x or 2x the horizontal line rate and are positioned 
according to the horizontal front porch.  Their width is described by the equalization 
(EQ) pulse width. 

1x Serr, 1x Eq – Serration pulses are generated at 1x the horizontal line rate.  
Equalization pulses are generated at 1x the horizontal line rate. 

2x Serr, 1x Eq – Serration pulses are generated at 2x the horizontal line rate (2 per line).  
Equalization pulses are generated at 1x the horizontal line rate. 

2x Serr, 2x Eq – Serration pulses are generated at 2x the horizontal line rate (2 per line).  
Equalization pulses are generated at 2x the horizontal line rate (2 per line). 

XOR – There are no serration or equalization pulses.  Horizontal sync pulses are 
effectively inverted during the vertical sync pulse. 

AND - There are no serration or equalization pulses.  There are no horizontal sync pulses 
are effectively inverted during the vertical sync pulse. 
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4.5.2 Output Timing Parameters 
The output timing parameters define the timing characteristics of the output video. 

4.5.2.1 Vertical 
A complete frame of interlaced video is made up of two fields.  Each field draws either 
even or odd numbered lines on the display. 

4.5.2.1.1 Frame Parameters 

Total 
Vertical Total defines the total number of lines of output video, including blanking, per 
frame. 

Active 
Vertical Active defines the number of active or visible lines of output video per frame. 

4.5.2.1.2 First Field 

Front Porch 
Vertical Front Porch defines the number of line periods between the end of active video 
(for the 1st field) and the beginning of the vertical sync pulse.  The resolution for the 
vertical front porch parameter is ½ lines.  This is to support the “2x Serr, 2x Eq.” sync 
format. 

VS Pulse Width 
VS Pulse Width defines the width of the vertical sync pulse in line periods.  The 
resolution for the VS pulse width parameter is ½ lines.  This is to support the “2x Serr, 1x 
Eq.” and “2x Serr, 2x Eq.” sync formats. 

Eq Pulses Before 
Eq. Pulses Before defines the number of consecutive line periods before VSync that have 
equalization pulses. 

Eq Pulses After 
Eq. Pulses After defines the number of consecutive line periods after VSync that have 
equalization pulses. 

Polarity 
Vertical Polarity defines the polarity of the vertical sync pulse.  Select Positive if the 
pulse is active high and Negative if the pulse is active low. 
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4.5.2.2 Horizontal 

4.5.2.2.1 Total 
Horizontal Total defines the total number of pixels in one line of output video, including 
blanking. 

4.5.2.2.2 Active 
Horizontal Active defines the number of active or visible pixels of one line of output 
video. 

4.5.2.2.3 Front Porch 
Horizontal Front Porch defines the number of pixels between the end of active video and 
the beginning of the vertical sync pulse.   The horizontal front porch may be entered in 
units of pixels or time. 

4.5.2.2.4 LS Pulse Width 
The Line Sync Pulse Width defines the width of the horizontal sync pulses outside the 
vertical blanking interval and outside the region surrounding the VSync pulse covered by 
equalization pulses.  The line sync pulse width may be entered in units of pixels or time. 

4.5.2.2.5 EQ Pulse Width 
The Equalization Pulse Width defines the width of the equalization pulses that lead and 
trail the VSync pulse.  The equalization pulse width may be entered in units of pixels or 
time. 

4.5.2.2.6 FS Pulse Width 
The Field Sync (Serration) Pulse Width defines the width of the serration pulses.  (The 
serration pulses occur within the VSync pulse.)  The field sync (serration) pulse width 
may be entered in units of pixels or time. 

4.5.2.2.7 Polarity 
Horizontal Polarity defines the polarity of the horizontal sync pulses.  Select Positive if 
the pulses are active high and Negative if the pulses are active low. 



VP7configure™ User’s Manual                                                                                                 Revision 7.0.4 

 

 

4.6 Scale and Position 
The “Scale and Position” step configures the parameters that define the video I/O 
relationship.  It has support for selecting, scaling and positioning an area of interest (AOI) 
from the input video onto the output video. 

This is the third step in the configuration process.  To go directly to this step, click the 
button under “Step #3:  Scale and Position.” 

 
Figure 24 Scale and Position 

Westar Display Technologies, Inc. 
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4.6.1 Defining the Output Video 
There are three steps in defining the content of the output video.  First, select an area of 
interest (AOI) from the active area of the input video.  Second, scale and position the 
AOI into the active area of the output video.    Third, define the color to be used to fill 
any of the output active area that is not covered by the scaled and positioned AOI. 

4.6.1.1 Area of Interest 
The area of interest in the input video (AOI) is selected in the “Area of Interest” frame.  
The main window for selecting the AOI is proportional to the active area of the input 
video. 

The area of interest is selected by entering the offset and size, or selecting it within the 
“Area of Interest” window.  The AOI cannot go outside of the active area of the input 
video. 

 
Figure 25 Area of Interest 

Westar Display Technologies, Inc. 
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Entering the AOI Offset 
The offset of the AOI can be entered using the AOI Offset fields.  The vertical offset is 
the number of lines from the top of the input active area to begin the area of interest.  The 
horizontal offset is the number of pixels from the left of the input active area to begin the 
area of interest.  When these fields are changed, the position of the box in the “Area of 
Interest” window also changes. 

Entering the AOI Size 
The size of the area of interest can be entered using the AOI Size fields.  The vertical size 
is the number of lines in the AOI, and the horizontal size is the number of pixels in the 
area of interest.  When these fields are changed, the size of the box in the “Area of 
Interest” window also changes. 

Selecting the Area of Interest in the Window 
Within the “Area of Interest” window, the box can be moved and sized which coarsely 
selects the area of interest.  To move the box with the mouse, move the cursor inside the 

box, and the cursor will change into a “grabber” .  Click and hold the mouse button 

and the cursor will change into a “dragger” .  The box can then be dragged around 
within the window.  To change the size of the box, move the cursor to the border of the 
box, and the cursor will change into an arrow indicating the directions that the size can be 
changed in.  Click and drag to change the size.  When the box is moved, the “AOI” size 
and offset fields are updated. 

Full Screen 
To force the area of interest to be the entire input active area, select the option Full 
Screen.  When the area of interest is sized to be full screen, the option will be 
automatically selected. 

Preview Image 
A “preview image” can be used to represent an input source and show how the resulting 
output may appear.  To use an image select the button labeled Open… and an “Open 
Picture” window will appear.  A picture file with the extension “.bmp,” “.jpg,” or “.gif” 
may be used.  If a picture is not chosen, a default image is used.  When a change is made 
in the AOI or scale and position (see section 4.6.1.2), the image in the windows will be 
redrawn accordingly. 

Westar Display Technologies, Inc. 
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4.6.1.2 Scale and Position 
The scale and position of the area of interest (Scaled AOI) is set in the “Scale and 
Position” frame.  The window for setting the scaled AOI is proportional to the active area 
of the output. 

The scaled AOI is set by entering the offset and size, or setting it within the “Scale and 
Position” window.  The scaled AOI cannot go outside the output active area.  The 
minimum vertical size of the scaled AOI is one half of the area of interest size plus one 
line.  The minimum horizontal size of the scaled AOI is one half of the area of interest 
size plus one pixel. 

 
Figure 26 Scale and Position 

Entering the Scaled AOI Offset 
The offset of the scaled AOI can be entered using the Scaled AOI Offset fields.  The 
vertical offset is the number of lines from the top of the output active area.  The 
horizontal offset is the number of pixels from the left of the output active areas.  When 
these fields are changed, the position of the picture in the “Scale and Position” window 
also changes. 

Entering the Scaled AOI Size 
The size of the scaled AOI can be entered using the Scaled AOI Size fields.  The vertical 
size is the number of lines in the scaled AOI, and the horizontal size is the number of 
pixels in the scaled AOI.  When these fields are changed, the size of the picture in the 
“Scale and Position” window also changes. 

Westar Display Technologies, Inc. 
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Setting the Scaled AOI in the Window 
Within the “Scaled AOI” window, the picture can be moved and sized which coarsely 
sets the scaled AOI.  To move the picture with the mouse, move the cursor inside the 

picture, and the cursor will change into a “grabber” .  Click and hold the mouse 

button and the cursor will change into a “dragger” .  The picture can then be 
dragged around within the window.  To change the size of the picture, move the cursor to 
the border of the picture, and the cursor will change into an arrow indicating the 
directions that the size can be changed.  Click and drag to change the size.  When the 
picture is moved, the “Scaled AOI” size and offset fields are updated. 

Window Scaled AOI 
To force the scaled AOI size and offset to match the AOI, select the option Window.  If 
the scaled AOI is sized and positioned to match the AOI, the option will be selected 
automatically. 

Flip Scaled AOI 
The scaled AOI can be flipped vertically or horizontally as part of the output video.  To 
flip the scaled AOI vertically, select the Flip Vertical option.  When using the “Flip 
Vertical” option, it is recommended that “Frame Ratio” be used as the output sync 
source.  This provides greater stability.  To flip the scaled AOI horizontally, select the 
Flip Horizontal option.

  
Figure 27 Normal Image Figure 29 Flipped Vertically 

  
Figure 28 Flipped Horizontally Figure 30 Flipped Vertically and Horizontally
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4.6.1.3 Fill Color 
A solid color is used to fill the rest of the output video.  The color is set using “Fill 
Color.”  Select the color using the sliders, or entering a value from 0 to 255 for each color 
component (RGB).  The color will be shown in the in “Scale and Position” window. 

 
Figure 31 Fill Color 
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4.7 Power Sequences (VP7s with firmware version 6.0 and 
later) 

Sequences of actions to take at critical events, and options for OSD (On-Screen Display) 
and flat field color are setup under the “Power Sequences” step.  If the firmware version 
of the VP7 board connected is earlier than 6.0, or the file open was created for such a 
board, refer to section 4.8.  This is the fourth step in the configuration process.  To go 
directly to this step, click the button under “Step #4:  Power Sequences.” 

 
Figure 32 Power Sequences 
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4.7.1 Setting Power Sequences 
There are four critical events which can a power sequence to be run:  when the board is 
being initialized, when the panel is command to power down, when valid video is 
detected, and when valid video is lost. 

Board Powered On

Run Board
Initialization
Sequence

Apply Commanded Power Up
Commanded

Power Down
Commanded

Run Panel Power
Down Sequence

Has Valid Video
Been Detected?Yes

Run Video
Detected
Sequence

Has Valid Video
Been Lost?

Run Video Lost
Sequence

Yes

Firmware or FPGA
Update

 
Figure 33 Power Sequence Events 

Westar Display Technologies, Inc. 

39 



VP7configure™ User’s Manual                                                                                                 Revision 7.0.4 

 

 

To edit a sequence, click Edit under the sequence type of sequence.  An editor window 
will then appear. 

 
Figure 34 Power Sequence Editor 

To add a new step to the sequence, click Add Step.  To define a step, first click the cell 
under “Action” for the step you are editing, and select an action from the list.  Once the 
action is selected, select the “Parameter” by clicking the cell and selecting a parameter 
from the drop-down list. 

If the action is “Delay,” enter the delay time in the cell.  “Drive Flat Field" has no 
parameter associated with it. 

If the action is “OSDX,” enter the time that the OSD should remain on the screen.  If the 
OSD should remain indefinitely, select the ∞ option.  If the OSD is driven as part of the 
“Power Up” sequence, the OSD will remain on the screen for the allotted time.  For other 
sequences, the OSD will remain on the screen for the allotted time or until the next 
critical event occurs which causes a power sequence to run. 

To move a step up in the order, select the step and click Move Step Up.  To move a step 
down, click Move Step Down.  To delete a step, select the step and click Delete Step.  
Once editing is completed, click OK.  To cancel editing and discard any changes, click 
Cancel. 

After exiting the edit window, the sequence will be shown in the box above the “Edit” 
button.  To clear the sequence, click Clear. 

To force the “Video Detected” sequence to match the “Board Initialization” sequence, 
click Same as Board Initialization Sequence.  To force the “Video Detected” sequence 
to match the “Board Initialization” sequence, click Same as Board Initialization 
Sequence.  If the sequences happen to match, the options will be selected automatically. 
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4.7.1.1 Sequence Actions 
Action Description Parameter 

UUT Power Power to the panel being driven ON, OFF 
Video Video to the panel being drive ON, OFF 
Backlight Power Power to the backlight being driven ON, OFF 
Backlight On/Off Discrete to turn on/off the backlight HIGH, GROUND 
Discrete 0 Discrete output voltage HIGH, GROUND 
Discrete 1 Discrete output voltage HIGH, GROUND 
Discrete 2 Discrete output voltage HIGH, GROUND 
Discrete 3 Discrete output voltage HIGH, GROUND 
Discrete 4 Discrete output voltage HIGH, GROUND 
Discrete 5 Discrete output voltage HIGH, GROUND 
Discrete 6 Discrete output voltage HIGH, GROUND 
Discrete 7 Discrete output voltage HIGH, GROUND 
Discretes Enable Enables Discrete output ON/OFF 
Power Supply 0 Discrete output voltage to power supply HIGH, GROUND 
Power Supply 1 Discrete output voltage to power supply HIGH, GROUND 
Power Supply 2 Discrete output voltage to power supply HIGH, GROUND 
Power Supply 3 Discrete output voltage to power supply HIGH, GROUND 
Power Supply Enable Enables Power Supply discrete output ON/OFF 
OSD1 On-Screen Display 1 displayed for time Time (sec) 
OSD2 On-Screen Display 2 displayed for time Time (sec) 
OSD3 On-Screen Display 3 displayed for time Time (sec) 
Drive Flat Field Drive the screen to a flat color none 
Delay Delay for time Time (msec) 
 
 

4.7.2 Sequence Options 
Options for the power sequences can be set up under “Sequence Options.” 

4.7.2.1 Delay 
To delay an action after video is lost, enter the delay time in tenths of seconds into delay. 

4.7.2.2 Field Color 
If you selected “drive display to flat field,” select the color under “Field Color.”  Select 
the color using the sliders, or entering a value from 0 to 255 for each color component 
(RGB). 
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4.7.2.3 OSD Options 
As part of a power sequence, An OSD (On-Screen Display) may be shown with a 
message.  To configure the OSD message box, click OSD Options.  There are three OSD 
configurations that can be set up.  Click the tab labeled OSD1, OSD2, or OSD3 to 
choose.  Once finished, click OK to remember the settings and return the ‘Power 
Sequences, or Cancel to return without any changes.  (*NOTE* OSD Options are 
enabled only in Firmware version 3.6 or later, and will be disable otherwise.) 

 
Figure 35 OSD Options 
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4.7.2.3.1 Scale 
Four different sizes for the OSD message box can be selected.  Click Scale and choose 
between 1X to 4X depending on the size of your display and preference. 

4.7.2.3.2 OSD Offset 
The position of the OSD message box is set under ‘OSD Offset.’  Enter the horizontal 
position of the left edge of the OSD box in H (pixels).  Enter the vertical position of the 
top edge of the OSD box in V (lines).  The position can also be set by moving the box 

around inside the positioning window using the grabber . 

Click Centered to enter a horizontal and vertical offset that will center the OSD box in 
the output video.  If a position is entered that happens to be centered, the option will be 
selected automatically. 

4.7.2.3.3 Flip OSD Vertically 
Select Flip OSD Vertically to flip the OSD vertically in the output video. 

4.7.2.3.4 Flip OSD Horizontally 
Select Flip OSD Horizontally to flip the OSD horizontally in the output video. 

4.7.2.3.5 OSD Message 
Enter the message that you would like to be display under ‘OSD Message.’  The message 
can be 3 lines of 20 characters each.  Center the message using spaces, if desired.  
(*NOTE* When the settings are applied, the OSD message is automatically saved in the 
VP7.) 

4.7.2.3.6 Foreground Color 
Enter the color of the OSD foreground (or characters) under ‘Foreground Color.’  Select 
the color using the sliders, or entering a value from 0 to 255 for each color component 
(RGB).  (*NOTE* When the settings are applied, the foreground color is automatically 
saved in the VP7.) 

4.7.2.3.7 Background Color 
Enter the color of the OSD background under ‘background Color.’  Select the color using 
the sliders, or entering a value from 0 to 255 for each color component (RGB).  (*NOTE* 
When the settings are applied, the background color is automatically saved in the VP7.) 

4.7.2.3.8 OSD Preview 
To see what the OSD will look like in the output video, click Refresh Preview.  The 
OSD box will be redrawn based on the settings. 
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4.8 Power Sequences (VP7s with firmware versions earlier 
than 6.0) 

Power sequences for the display and backlight being driven, and the action to take when 
loss of video is detected are setup in the “Power Sequences” step.  This is the fourth step 
in the configuration process.  If the firmware version of the VP7 connected is earlier than 
6.0, or the file opened was created for such a board, this interface is used.  Otherwise, 
refer to section 4.7.  However, files previously created for boards with firmware earlier 
than 6.0 can still be loaded on boards with firmware later than 6.0.  To go directly to this 
step, click the button under “Step #4:  Power Sequences.” 

 
Figure 36 Power Sequences 
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4.8.1 Setting Power Sequences 
The sequence of events to turn on and off the panel and backlight are set up under “Panel 
Power Sequences” and “Backlight Power Sequences.”  The sequences for the panel and 
backlight are set up separately, with a sequence to power up and power down. 

To edit a sequence, click Edit under the sequence type of sequence.  An editor window 
will then appear. 

 
Figure 37 Power Sequence Editor 

To add a new step to the sequence, click Add Step.  To define a step, first click the cell 
under “Action” for the step you are editing, and select an action from the list.  There are 
different options for “Action” depending on whether it is a panel or backlight power 
sequence.  Once the action is selected, select the “Parameter” by clicking the cell and 
selecting a parameter from the drop-down list.  If the action is “Delay,” enter the delay 
time in the cell. 

To move a step up in the order, select the step and click Move Step Up.  To move a step 
down, click Move Step Down.  To delete a step, select the step and click Delete Step.  
Once editing is completed, click OK.  To cancel editing and discard any changes, click 
Cancel. 

After exiting the edit window, the sequence will be shown in the box above the “Edit” 
button.  To clear the sequence, click Clear. 
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4.8.1.1 Panel Actions 
Action Description Parameter 

UUT Power Power to the panel being driven ON, OFF 
Video Video to the panel being drive ON, OFF 
Discrete 0 Discrete output voltage HIGH, GROUND 
Discrete 1 Discrete output voltage HIGH, GROUND 
Discrete 2 Discrete output voltage HIGH, GROUND 
Discrete 3 Discrete output voltage HIGH, GROUND 
Discrete 4 Discrete output voltage HIGH, GROUND 
Discrete 5 Discrete output voltage HIGH, GROUND 
Discrete 6 Discrete output voltage HIGH, GROUND 
Discrete 7 Discrete output voltage HIGH, GROUND 
Discretes Enable Enables Discrete output ON/OFF 
Power Supply 0 Discrete output voltage to power supply HIGH, GROUND 
Power Supply 1 Discrete output voltage to power supply HIGH, GROUND 
Power Supply 2 Discrete output voltage to power supply HIGH, GROUND 
Power Supply 3 Discrete output voltage to power supply HIGH, GROUND 
Power Supply Enable Enables Power Supply discrete output ON/OFF 
Delay Delay for time Time (msec) 

4.8.1.2 Backlight Actions 
Action Description Parameter 

Backlight Power Power to the backlight being driven ON, OFF 
Backlight On/Off Discrete to turn on/off the backlight HIGH, GROUND 
Discrete 0 Discrete output voltage HIGH, GROUND 
Discrete 1 Discrete output voltage HIGH, GROUND 
Discrete 2 Discrete output voltage HIGH, GROUND 
Discrete 3 Discrete output voltage HIGH, GROUND 
Discrete 4 Discrete output voltage HIGH, GROUND 
Discrete 5 Discrete output voltage HIGH, GROUND 
Discrete 6 Discrete output voltage HIGH, GROUND 
Discrete 7 Discrete output voltage HIGH, GROUND 
Discretes Enable Enables Discrete output ON/OFF 
Delay Delay for time Time (msec) 
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4.8.2 Video Lost Action 
When the loss of valid input video is detected, the power down sequence of the panel 
and/or backlight can be run, or the display can be driven to a flat color field.  

 
Figure 38 Video Lost Action 

4.8.2.1 Delay 
To delay an action after video is lost, enter the delay time in tenths of seconds into delay. 

4.8.2.2 Action 
Select the action to take by clicking on the corresponding button.  Select drive display to 
flat field to drive the display to a solid color indicated by “Field Color.”  Select power 
down the panel to run the panel power down sequence.  Select power down the 
backlight to run the backlight power down sequence.  Select power down the panel and 
backlight to run the panel and backlight power down sequences. 

4.8.2.3 Field Color 
If you selected “drive display to flat field,” select the color under “Field Color.”  Select 
the color using the sliders, or entering a value from 0 to 255 for each color component 
(RGB). 
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4.8.2.4 OSD Options 
If you are driving the screen to a flat field when video is lost, an OSD (On-Screen 
Display) may also be shown with a message.  To configure the OSD message box, click 
OSD Options.  Once finished, click OK to remember the settings and return the ‘Power 
Sequences, or Cancel to return without any changes.  (*NOTE* OSD Options are 
enabled only in Firmware version 3.6 or later, and will be disable otherwise.) 

 
Figure 39 OSD Options 

4.8.2.4.1 Enable OSD When Video is Lost 
To enable the OSD, select the option Enable OSD When Video is Lost.  De-select the 
option if you do not want an OSD to be shown when video is lost. 

4.8.2.4.2 Flip OSD Vertically 
Select Flip OSD Vertically to flip the OSD vertically in the output video. 
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4.8.2.4.3 Flip OSD Horizontally 
Select Flip OSD Horizontally to flip the OSD horizontally in the output video. 

4.8.2.4.4 Scale 
Four different sizes for the OSD message box can be selected.  Click Scale and choose 
between 1X to 4X depending on the size of your display and preference. 

4.8.2.4.5 Position 
The position of the OSD message box is set under ‘Position.’  Enter the horizontal 
position of the left edge of the OSD box in H (pixels).  Enter the vertical position of the 
top edge of the OSD box in V (lines). 

Click Centered to enter a horizontal and vertical offset that will center the OSD box in 
the output video.  If a position is entered that happens to be centered, the option will be 
selected automatically. 

4.8.2.4.6 OSD Message 
Enter the message that you would like to be display under ‘OSD Message.’  The message 
can be 3 lines of 20 characters each.  Center the message using spaces, if desired.  
(*NOTE* When the settings are applied, the OSD message is automatically saved in the 
VP7.) 

4.8.2.4.7 Foreground Color 
Enter the color of the OSD foreground (or characters) under ‘Foreground Color.’  Select 
the color using the sliders, or entering a value from 0 to 255 for each color component 
(RGB).  (*NOTE* When the settings are applied, the foreground color is automatically 
saved in VP7s with firmware versions earlier than 6.0.) 

4.8.2.4.8 Background Color 
Enter the color of the OSD background under ‘background Color.’  Select the color using 
the sliders, or entering a value from 0 to 255 for each color component (RGB).  (*NOTE* 
When the settings are applied, the background color is automatically saved in the VP7s 
with firmware versions earlier than 6.0.) 
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4.9 Contrast and Brightness Control 
The parameters for manually controlling the contrast and backlight inverter (brightness) 
of the display being driven are set up under “Contrast\Brightness Control.”   This is the 
fifth step in the configuration process.  To go directly to this step, click the button under 
“Step #5:  Output Setup.”  

 
Figure 40 Contrast\Brightness Setup 

4.9.1 Contrast Setup 
The method of contrast control and the “Contrast Table” to use are selected under 
“Contrast Setup.”  (See section 7 for more about the Contrast Tables). 

4.9.1.1 Control Method 
Select the method of manually controlling the contrast under “Control Method.” 

Analog 
Select Analog to use the analog input to the VP7 as the control. 

If “Analog” is selected, the options under “Contrast Table” will change.  Select between -
9 to 9V (32 steps), 0 to 5V (16 steps), 0 to 9V (32 steps).  
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Digital 
Select Digital to use the digital contrast control. 

If “Digital” is selected, the options under “Contrast Table” will change.  Select between 
32 step and 16 steps.  

Remote 
Select Remote to use remote commands to control the contrast. 

None 
Select None if you do not wish to manually control the contrast.  The contrast will be set 
to the value made under “Color Adjustments” (section 4.8.1).  

4.9.1.2 Contrast Table Editor 
Click Contrast Table Editor to launch the “Contrast Table Editor” (see section 7.1). 

4.9.1.3 Power Up Value 
The “Power Up Value” is the step that the contrast is set to when the board is powered 
up.  This is only used if the digital control is used. 

Power Up Last Value 
Select Power Up last value to have the board remember the last contrast step when it 
was last powered down.   

Power Up Default Value 
Select Power Up default value to have the board power up with the same contrast step 
every time.  Enter the value into the box beside the option.  The range for the value is 1 to 
32 if Table 1 is used, and 1 to 16 if Table 2 is used. 

4.9.1.4 Digital Control Interface 
The “Digital Control Interface” selects the type of digital input used for control if 
“Digital” is selected.  Select Push Button if the control is two buttons.  Select Encoder 
is the control is a digital encoder, such as a knob. 

4.9.1.5 Increment Delay Time 
“Increment Delay Time” sets how quickly the contrast step is incremented when the 
digital control is held down.  The delay time is the time between each increment. 

Initial 
The “Initial” delay is the time between each increment during the first four steps, as the 
digital control is held down.  The time can range from 0 to 1912.5 microseconds. 

Final 
The “Initial” delay is the time between each increment after four steps, as the digital 
control is held down.  The time can range from 0 to 1912.5 microseconds. 
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4.9.2 Backlight Inverter Setup 
The method of the backlight inverter level control and the backlight inverter level to use 
at power up are selected under “Backlight Inverter Setup.” 

4.9.2.1 Control Method 
Select the method of manually controlling the backlight inverter level under “Control 
Method.” 

Digital 
Select Digital to use the digital backlight inverter voltage level control. 

Remote 
Select Remote to use remote commands to control the backlight inverter level. 

None 
Select None if you do not wish to manually control the backlight inverter level. 

4.9.2.2 Power Up Value 
The “Power Up Value” is the value that the backlight inverter level is set to when the 
board is powered up.   

Power Up Last Value 
Select Power Up last value to have the board remember the last backlight inverter level 
value when it was last powered down.   

Power Up Default Value 
Select Power Up default value to have the board power up with the same backlight 
inverter level every time.  Enter the value into the box beside the option.  The range for 
the value is 0 to 63. 

4.9.2.3 Digital Control Interface 
The “Digital Control Interface” selects the type of digital input used for control if 
“Digital” is selected.  Select Push Button if the control is two buttons.  Select Encoder 
is the control is a digital encoder, such as a knob. 

4.9.2.4 Increment Delay Time 
“Increment Delay Time” sets how quickly the backlight inverter level is incremented 
when the digital control is held down.  The delay time is the time between each 
increment. 

Initial 
The “Initial” delay is the time between each increment during the first four steps, as the 
digital control is held down.  The time can range from 0 to 1912.5 microseconds. 
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Final 
The “Initial” delay is the time between each increment after four steps, as the digital 
control is held down.  The time can range from 0 to 1912.5 microseconds. 

4.9.2.5 Digital Steps 
“Digital Steps” are the number of steps or increments between minimum and maximum 
backlight inverter brightness.  The choices are 64, 32, or 16. 

 



VP7configure™ User’s Manual                                                                                                 Revision 7.0.4 

 

 

4.10 Input Capture Adjustments 
Adjustments are made to the input ADC sampling clock phase and capture boundaries 
during the “Input Capture Adjustments” step.  Also, adjustments to the color of the 
captured input video can be made. 

 
Figure 41 Input Capture Adjustments 
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4.10.1 Color Adjustments 
Adjustments to the color of the input source can be made under “Color Adjustments.”   
The check boxes offer the capability to kill chroma in YUV color space (leaving a 
grayscale image) or to kill the R, G, or B color component after the YUV to RGB 
conversion.  Standard black level, contrast and brightness adjustments can be made to R, 
G and B independently. 

 
Figure 42 Color Adjustments 

4.10.1.1 Chroma Kill 
The YUV Color checkbox offers the ability to set the chrominance saturation to zero 
(unchecked) in YUV color space, leaving a grayscale image.  The RGB checkboxes offer 
the ability to zero (unchecked) the R, G, and B color components after the internal YUV 
to RGB color space conversion.  This capability can be useful for night vision 
applications. 

4.10.1.2 Black Level 
The Black Level value is subtracted from the color data from the input source.  The 
default value is “0.”  It can range from 0 to 255. 

4.10.1.3 Contrast 
Color data from the input source is multiplied by the Contrast value.  The default value 
is “1.”  It can range from 0 to 1.998. 

4.10.1.4 Brightness 
The Brightness value is added to the color data from the input source.  The default value 
is “0.”  It can range from 0 to 255. 

 

When used in conjunction, the color adjustments follow the following equations: 

R(out) = (R – RedBlackLevel) * RedContrast + RedBrightness 

G(out) = (G – GreenBlackLevel) * GreenContrast +GreenBrightness 

B(out) = (B – BlueBlackLevel) * BlueContrast + BlueBrightness 

The black level is applied first, followed by contrast, and then brightness. 
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4.10.2 Timing Adjustments 
To use the timing adjustments, a valid video source must be connected to the video input.  
It is recommended that the video output also be connected so the adjustments can be 
seen.  Before making timing adjustments, all the parameters must be applied.  If the 
parameters have not been applied, the adjustments will be disabled.  Also, if a VP7™ is 
not connected, the timing adjustments will be disabled. 

4.10.2.1 Sweep ADC Phase 
Click Sweep ADC Phase to run a test of different phase delays of the analog to digital 
converter sampling clock.  The process takes several minutes to complete.  When using 
the test, apply a pattern with high horizontal and vertical frequency content as the source, 
or a “busy” image. 

 
Figure 43 ADC Phase Plot 

The phase delay is varied over a range of 0 to 511.  For each delay, the sum of 
differences of consecutive pixel data is measured and plotted in the graph.  As the test 
progresses, the delay the yields the highest difference is tracked.  The best delay to 
choose corresponds to the peak of the widest sum of difference cycle. 

To stop the testing at any time, click STOP.   

After the test has been run, the delay that yields highest difference is applied.  The phase 
delay can also be selected manually by clicking on the graph or entering it into ADC 
Phase.  Click Set to program the delay if you wish to set it manually. 

4.10.2.2 Input Boundary Detect 
Clicking Input Boundary Detect adjusts the input capture area so the entire area is 
captured correctly.  When running the “Input Boundary Detect,” apply a pattern that 
defines the input active area as set up in Step #1:  Input Setup.  When it completes, if the 
pattern did not appear to define the input active area, a message will appear. 

To manually adjust the input boundary, click any of the arrow buttons surrounding the 
“Input Boundary Detect” button.  The input boundary will shift in the opposite direction 
of the arrow, causing the output image to shift in the direction of the arrow.  As the image 
is adjusted, the offsets are shown in “Horizontal Adjust” and “Vertical Adjust.”  To reset 
the adjustments to zero, click Reset. 
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4.11 Applying, Saving, and Restoring Parameters 
The Apply, Save, and Restore buttons appear at every step of the wizard at the bottom of 
the window, and in the VP7configure™ Wizard window.  To use any of the buttons, a 
VP7™ must be connected.  If one is not connected, an error message will appear if any of 
the buttons are clicked. 

 
Figure 44 Apply, Save, Restore 

4.11.1 Apply 
Clicking Apply sends all the parameters to the volatile memory of the VP7™, and 
applies them.  If there is a problem with one of the parameters, a message box will appear 
saying which set of parameters has a problem.  The parameters will not be applied if 
there is an error. 

After the “Apply” is done, the Apply button will be disabled and the Save button will be 
enabled.  Apply will be enabled again when there is a change to one of the parameters, 
and Save will be disabled. 

4.11.2 Save 
Clicking Save stores the parameters for the VP7™ channel.  The parameters that are in 
memory are copied into non-volatile memory, so the VP7™ channel can remember the 
parameters the next time it is powered down. 

When the Apply button is enabled, meaning there is unapplied changes to the parameters, 
the Save button is disabled.  The Save button is enabled after the current parameters are 
successfully applied to the VP7™ channel. 

4.11.3 Restore 
Clicking Restore reads back the parameters stored in nonvolatile memory of the VP7™ 
channel into volatile memory.  The parameters are then reapplied and read into the 
VP7configure™ program.  This can be used to discard recent changes and return to the 
last saved state. 
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5 Saving a Connection 
Files are saved as text files (*.txt) containing VP7™ text commands. 

To save a set of parameters to the PC, select File->Save from the menu, click the Save 
button in the VP7configure™ Wizard window, or press Ctrl + S on the keyboard.  If you 
haven’t saved the connection before, it will ask for a text file name.  You may enter a 
new name, or replace an existing file.  If you have saved already, it will not ask for a file 
name and save it under the same name. 

After a file is saved, the file name will be displayed in the title bar of the VP7configure™ 
Wizard window.  Before it is saved, it is given a default name. 

  
Figure 45 Unsaved File Figure 46 Saved File

To save an already saved connection under a different file name, select File->Save As… 
from the menu, or click the Save As… button in the VP7configure™ Wizard window.  
The program will then prompt for a text file name to save under. 
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6 Opening a Connection 
Text files containing VP7™ commands or files saved by VP7configure™ can be opened 
and loaded into the VP7configure™ Wizard. 

To open an existing file, select File->Open Connection from the menu or press Ctrl + O 
on the keyboard.  Choose the text file (*.txt) you wish to open. 

VP7configure™ checks each line in the file, and, if it is a valid VP7™ command, loads 
its parameters into the VP7configure™ Wizard.  If there is an invalid line in the file, an 
error message will be displayed showing the invalid line.  If an error message appears, 
click OK to continue reading the rest of the file, or click Cancel to stop. 

 
Figure 47 Invalid Line 
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7 Creating a Project 
If multiple tables (configuration sets) are being used in the VP7™, a project can be 
created to link to and sort wizard files associated with each table.  To create a new project 
for a VP7™, select File->New Project from the menu bar.  The VP7configure™ Project 
window will appear. 

 
Figure 48  Project Window 

7.1 Adding Files 
To add a file to a table, right click on the table, and select Enter File… from the popup 
menu or double click an empty table slot.  Then select a VP7™ file from the browser.  If 
the file is a valid VP7™ file, the resolution and input format will be added to the tree as 
subsets of the Table.  Click the plus sign (“+”), to show the properties, or the minus sign 
(“-“) to hide them. 

7.2 Removing Files 
To remove a file from a table slot, right click on the table, and select Remove File.  The 
slot will then display “empty.” 

7.3 Viewing/Editing Files 
To view or edit a file, right click on the Table, and select View File… from the popup 
menu, or double click the table.  A wizard window for the file will then appear.  The 
“Connection” frame will be disabled, since it is controlled from the project window.  If 
you wish to read up the settings from the table in the VP7™, click Restore. 

7.4 Sorting Files 
To move or insert a file to a different table, simply drag the file from the original table, to 
the table it will reside in.  The rest of the tables will be sorted accordingly. 
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7.5 Connecting to a VP7™ through the Project Window 
To connect to a VP7™ through the project window, connect the RS-232 connector of the 
VP7™ to the RS-232 communications port on the computer.  Select the COM port 
number from the COM: drop-down menu.  Then click the red To Connect button.  

 
Figure 49 Connect 

If a VP7™ is not detected, a message box will appear indicating so. 

If the VP7™ was in AUTO mode, it will be set to fixed mode while editing, and can then 
be set back to AUTO mode upon disconnecting.  A message will appear indicating this.   

After connecting, the button labeled “To Connect” will change to green and be labeled 
“To Disconnect.”  The “Table” (see section 4.1.1), “Firmware Version,” and “FGPA 
Revision” will be shown.  To disconnect from a VP7™, click the green To Disconnect 
button. 

 
Figure 50 Disconnect 

7.5.1 Selecting a Table 
The VP7™ allows for 8 different “tables,” or configuration sets.  Once a VP7™ is 
connected, the “Table” drop down list will be enabled, and the table number will be 
automatically selected.  To change the table, click the drop down list, and select from 0 
through 7.   
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7.5.2 AUTO Table Selection 
The VP7™ can be set up to automatically load the table which matches the input video.  
A table must be created for every possible input video to use auto-mode.  Using AUTO 
mode is not recommended when the input video is constant.  AUTO mode is only 
supported in VP7™ firmware version 3.0 and later. 

To enable AUTO mode, select AUTO on Disconnect.  The option will have been already 
selected if the VP7™ was already in AUTO mode when connected.  The VP7™ will be 
set to AUTO upon disconnecting.  To disable AUTO mode, deselect AUTO on 
Disconnect, and click To Disconnect. 

7.6 Saving Tables to VP7 
To save the tables to the VP7™, click Save Tables to VP7.  Each table with a VP7™ file 
associated with it will then be saved off to the VP7™. 
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8 Saving a Project 
Project files are saved with the extension .vpp. 

To save a project to the PC, select File->Save Project Settings from the menu.  If the 
project has not been saved before, it will ask for a file name.  You may enter a new name, 
or replace an existing file.  If the file has been saved already, it will not ask for a file 
name and save it under the same name.  Note that when a project is saved, the tables 
themselves are not saved.  Those must be saved individually if you wish to edit them (see 
section 5). 

After a file is saved, the file name will be displayed in the title bar of the VP7™ Project 
window.  Before it is saved, it is given a default name. 

  
Figure 51 Unsaved File Figure 52 Saved File

To save an already saved connection under a different file name, select File->Save 
Project Settings As… from the menu.  The program will then prompt for a text file name 
to save under. 

Westar Display Technologies, Inc. 
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9 Opening a Project 
To open an existing project file, select File->Open Project from the menu.  Choose the 
project file (*.vpp) you wish to open. 

The project tree is then populated with the files associated with each table.  If a file is not 
found, “(File not found)” will be displayed by the file name. 
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10  Contrast Tables 
The “Contrast Tables” are tables stored in the VP7™ which contain contrast values for 
each step of manual control.  There are three such tables for different analog voltage 
ranges and step numbers. 

If the contrast is being controlled by the analog input, one of the three tables can be used.  
Table 1 can be used for an input ranging from -9V to +9V, and has 32 steps.  Table 2 can 
be used for an input ranging from 0V to +5V, and has 16 steps.  Table 3 can be used for 
an input ranging from 0 to +9V, and has 32 steps. 

To select a value for the contrast under analog control, the input voltage is measured and 
compared to ranges for each step in the table.  For example, Table 1 is being used, which 
ranges from –9V to 9V.  The analog input is measured to be 0V.  Step 16 is chosen since 
0V falls within its range.  The contrast value stored in step 16 is used. 

If the contrast is being controlled by the digital contrast control, one of two tables can be 
used.  Table 1 can be used to have 32 contrast steps, and Table 2 can be used to have 16 
contrast steps.  The same contrast tables are used for digital control as the tables used for 
analog control, but the digital control disregards voltages ranges.  The step number to 
choose from the table is set by the digital counter. 
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10.1 Contrast Table Editor 
Use the “Contrast Table Editor” to change the contrast values stored in the contrast 
tables.  Select Maintenace->Contrast Table Editor to open the editor. 

 
Figure 53 Contrast Table Editor 

10.1.1 Editing a Table 
To edit a table, first select the tab for the table you wish to edit (Table 1, Table 2, or 
Table 3).  To change the contrast value for a certain step, move the slider beside the step 
number to the desired value.  As the slider moves, the “% Gain” is shown to the left. 

To return to the default table settings, click Restore Default Curves. 

To store the tables onto the VP7™, click Write to VP7 if a VP7™ is connected.  If one 
is not connected, this button is disabled. 

10.1.2 Saving a Table 
To save the settings for the tables to the PC, click Save.  Contrast table files are stored 
with the extension “*.cts.” 

10.1.3 Loading a Table 
To load a saved table settings file from PC, click Load.  You will then be prompted to 
select a file with the extension “*.cts.”  After selecting the file, its settings will be loaded 
into the editor. 
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11 Download Font Table 
If you are displaying an OSD as part of a power sequence, the Font Table will need to be 
downloaded to the VP7™.  Select Maintenance->Download Font Table from the menu 
to download the font table.  This needs to be done only once, as the table exists in non-
volatile memory.  In virtually all cases, the font table will already have been downloaded 
during production, and it will be unnecessary to use this feature.  If there is a problem 
with the OSD displaying, where the OSD box can be seen but the characters are invalid 
or not seen, it may be necessary to download the font table again.  Some future firmware 
versions may require the font table to be reloaded, which will be noted with the firmware 
release. 

This feature only allows for the default VP7™ font table to be loaded, but may be 
expanded for different tables in the future. 
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12 EDID 
The VP7™ contains an EDID, which some panels may require.  The information stored 
in the EDID can be read from or written to a VP7™. 

12.1 Reading the EDID 
To read the EDID information up from the VP7™, click Maintenance->Read EDID…  
You will then be prompted to save the file as a text file (*.txt) or a hex file (*.hex).  The 
text file contains hexadecimal values for each byte, delimited by a space.  The hex file is 
saved off in the standard hex format. 

12.2 Loading the EDID 
To load the EDID information into the VP7™, click Maintenance->Load EDID…  You 
will then be prompted to open a text file (*.txt) or a hex file (*.hex).  The text file must 
contain hexadecimal values for each byte.  The bytes can be delimited by any character 
that is not 0-9, A-F, a-f.  The hex file must be the standard hex format. 
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13 Updating the FPGA 
The VP7™ is designed so the FPGA can be updated in the field.  To update the FPGA, 
click Maintenance->Update FPGA… from the menu.  Select the FPGA file (*.rpd).  
Only use FPGA updates provided by Westar.  Loading an invalid file may render the 
board useless until a valid FPGA update is loaded. 
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14 Feedback Level 
Two different levels of feedback can be used when communicating with a VP7™.  To 
change the feedback level select Options->Set Feedback Level to High/Low. 

When “Low Feedback” is selected, if unexpected data is in the serial buffer while 
communicating with the VP7™, it will be ignored, unless it is an error.  When “High 
Feedback” is selected, any unexpected data in the serial buffer will be shown in a 
message box, and the current VP7™ communication will be stopped. 
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